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ScanAsPDF Software License (EULA) and Warranty 

Be sure to carefully read and understand the rights and restrictions 
described in the End-User License Agreement ("EULA"). You will be asked 
to review and either accept or not accept the terms of the EULA. This 
product will not install on your computer unless you accept the terms of 
the EULA. 
 
NOTE: THE TERMS OF A PRINTED PAPER EULA, WHICH MAY ACCOMPANY THE SOFTWARE, SUPERSEDES THE TERMS OF ANY ON-
SCREEN EULA FOUND WITHIN THE SOFTWARE. 
 
For your future reference, you may print the text of the EULA, or refer to a copy of the EULA that can be found in the LICENSE.TXT or 
JCITSEULA.PDF file in the Software installation folder.  
 
END-USER LICENSE AGREEMENT FOR JARRETT CONSULTING AND INFORMATION TECHNOLOGY SERVICES AND SYSTEMS (JCITS 
SYSTEMS), LLC SOFTWARE. 
 
IMPORTANT-READ CAREFULLY. THIS END-USER LICENSE AGREEMENT IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN 
INDIVIDUAL OR A SINGLE ENTITY) AND JCITS SYSTEMS FOR THE SOFTWARE PRODUCT(S) ACCOMPANYING THIS EULA SOFTWARE 
PRODUCTS INCLUDE(S) COMPUTER SOFTWARE AND MAY INCLUDE ASSOCIATED MEDIA, PRINTED MATERIALS, AND PRINTED OR 
ONLINE DOCUMENTATION ("SOFTWARE"). YOUR CLICK ON THE "YES" BUTTON BELOW, IS A SYMBOL OF YOUR SIGNATURE THAT 
YOU HAVE READ THESE TERMS AND ACCEPT THEM, AND IF YOU ARE ACCEPTING ON BEHALF OF AN ENTITY, THAT YOU ARE 
AUTHORIZED TO BIND SUCH ENTITY TO THE TERMS OF THIS EULA. IF YOU DO NOT ACCEPT THESE TERMS, JCITS SYSTEMS IS 
UNWILLING TO GRANT YOU THIS LICENSE AND YOU SHOULD CLICK ON THE "NO" BUTTON. 
 
This Software is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. 
The Software is licensed, not sold, and is not a sale of the original or any subsequent copy of the Software. Any reference to a "sale" or 
"purchase" of the Software in this EULA means the purchase of a license to use the Software. 
 
1. LICENSE GRANT: Subject to, and for so long as you comply with, the terms and conditions of this EULA, JCITS Systems, LLC, an 
Arizona Limited Liability Company, owned by John F. Jarrett, whose address is PO Box 1222, Show Low, Arizona 85902, USA, and its 
licensors, if any ("JCITS Systems") grants to you a personal, non-exclusive license (a "License") to use the Software solely on the terms set 
forth below. The Software includes any software updates, add-on components, and/or supplements to the original Software that JCITS 
Systems may provide to you or make available to you after the date that you obtain your initial copy of the Software (only to the extent that 
such items are not accompanied by a separate EULA or terms of use). JCITS Systems reserves all rights to the Software not expressly 
granted to you under this EULA.  
 
2. SCOPE OF LICENSE. THIS LICENSE GRANTS YOU THE FOLLOWING RIGHTS: 
* Software.  If the software is a demonstration, evaluation, FreeWare or ShareWare program, you are free to use, duplicate and distribute 
this software through the Internet or any preferred media and as outlined below. 
* If you have registered your demonstration, evaluation, FreeWare or ShareWare software and have obtained a license key to unlock all of 
the features of the software, or registration key, the license/registartion key file MAY NOT be distributed under any circumstance! Doing so 
will invoke severe criminal and civil damages. This file contains pertinent information about you, the licensee, and is designed to unlock all 
features of the software and allow tracking of illegal copies using a bogus, fake or copied license key. 
* You may ONLY distribute the demonstration, FreeWare or ShareWare software as an installable setup file or set of setup files with all 
notices, names and original files in tact, including this EULA. 
* Beta Software. If you received this License as part of any JCITS Systems Beta program, then this License will terminate upon the first 
public announcement by JCITS Systems that the commercial release of the Software is available, and you will be required to obtain a 
license for the commercial version of the Software in order to continue use.  All use of Beta Software must comply with the terms of the 
applicable JCITS Systems Beta program in addition to the terms set forth in this EULA. 
* Support. Information regarding support services for the Software is located within the JCITS Systems' Internet web site at 
www.JCITSSystems.com. Any supplemental software code provided to you as part of the support services shall be considered part of the 
Software and subject to the terms and conditions of this EULA. With respect to technical information you provide to JCITS Systems as part 
of the support services, JCITS Systems may use such information for its business purposes, including product support and development. 
JCITS Systems will not utilize such technical information in a form that personally identifies you.  
* JCITS Systems will not sell, rent or give away your pesonal information! 
* Subject to any limitations provided by this EULA, you may freely distribute copies of any files generated by the Software. 
 
3. RESTRICTIONS. 
* Reverse Engineering. Except to the extent that applicable laws specifically prohibit the following restrictions, and then only to the 
minimum extent permitted thereunder: You may not modify, translate, reverse engineer, decompile, disassemble, or otherwise attempt to 
re-create or discover the source code or other proprietary components of the Software, or create derivative works based on the Software, or 
any portion of the Software. 
* Separation of Components. The Software is licensed as a single product. You may not separate the Software's component parts for use on 
more than one computer unless specifically authorized and/or licensed. 
* Proprietary Notices. You may not remove any proprietary notices, labels or marks on the Software. 
* Use of JCITS Systems' Name. You may not use JCITS Systems or JCITS Systems' suppliers' names, logos, or trademarks in any manner 
including, without limitation, in your advertising or marketing materials, except for instances where they are automatically generated by 
the Software, or as may be necessary to affix the appropriate copyright or other proprietary notices as required by this EULA. 
* You may not permit any third party to perform any of the above restricted actions set forth in this RESTRICTIONS Section. 
* You may not misrepresent this software as being produced, written or compiled by you or other third party. 
* You may not crack, hack or otherwise make the software available as any compressed file, executable or crack.exe to make the software 
fully functional without a license from JCITS Systems. This will invoke severe civil and criminal penalties. 



 

4. TITLE. 
Subject to the License expressly granted to you by this EULA, all title, ownership rights, intellectual property rights, and all other rights 
and interest in and to the Software are vested in and shall remain in JCITS Systems and/or its suppliers. You agree that you neither own 
nor hereby acquire any claim or right of ownership to the Software (or any accompanying documentation) or to any related patents, 
copyrights, trademarks or other intellectual property rights. If applicable, you acquire title only to the magnetic or other physical media on 
which the Software and any related documentation are recorded or fixed. The Software is protected by the copyright laws and other 
intellectual property laws of the United States and international treaties. If this Software contains documentation provided only in 
electronic form, you may print one copy of such electronic documentation for each License.  
 
5. TERMINATION. 
The License is in effect until terminated. You may terminate this License at any time by ceasing any and all use of the Software, and 
deleting or otherwise destroying the Software. The License will terminate immediately and automatically if you breach any of the terms of 
this EULA or otherwise fail to comply with the limitations described in this EULA. On any termination, you must destroy all copies of the 
Software. Sections titled RESTRICTIONS, TITLE, LIMITED WARRANTY, LIMITATION OF LIABILITY, and GENERAL shall survive any 
termination of this EULA. 
 
6. EXPORT CONTROLS. 
This Software is subject to the export control laws of the United States. You may not export or re-export the Software or any part the 
Software without the appropriate United States and foreign government licenses. You shall otherwise comply with all applicable export 
control laws and shall indemnify, defend, and hold JCITS Systems and its suppliers harmless from any and all liabilities (including 
attorney's fees) arising from or related to your violation of such export control laws. 
 
7. U.S. GOVERNMENT END-USERS. 
The Software is a "commercial item," as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting of "commercial computer software" 
and "commercial computer software documentation," as such terms are used in 48 C.F.R. 12.212 (Sep 1995) and is provided to the U.S. 
Government only as a commercial end item. Any technical data provided with such Software is commercial technical data as defined in 48 
C.F.R. 12.211 (Sep 1995). Consistent with 48 C.F.R. 12.211 through 12.212, 48 C.F.R. 227.7202-1 through 227.7202-4 (Jun 1995), and 
48 C.F.R. 252.227-7015 (Nov 1995), all U.S. Government End Users acquire the Software with only those rights expressly set forth in this 
EULA. 
 
8. LIMITED WARRANTY. 
JCITS Systems warrants that the media containing the Software, if such media is provided by JCITS Systems, is free from defects in 
material and workmanship and will so remain for ninety (90) days from the date you acquired the Software. JCITS Systems' sole liability, 
and your sole and exclusive remedy, for any breach of this warranty shall be in JCITS Systems' sole discretion to replace your defective 
media. Replaced Software shall be covered by this limited warranty for the period remaining under the warranty that covered the original 
Software, or if longer, for thirty (30) days after the date of shipment to you of the replaced Software. Only if you inform JCITS Systems of 
such defect with the Software during the applicable warranty period and provide evidence of the date you acquired the Software will JCITS 
Systems be obligated to honor this warranty. JCITS Systems will use commercially reasonable efforts to replace or refund pursuant to the 
foregoing warranty within thirty (30) days of being so notified. THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY 
JCITS SYSTEMS. EXCEPT FOR THE LIMITED WARRANTY SET FORTH IN THIS EULA, TO THE MAXIMUM EXTENT ALLOWED UNDER 
APPLICABLE LAW, THE SOFTWARE IS PROVIDED "AS IS" AND JCITS SYSTEMS MAKES NO OTHER WARRANTY, REPRESENTATION, OR 
CONDITION, EXPRESS, IMPLIED, OR STATUTORY, AND EXPRESSLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. JCITS SYSTEMS DOES NOT WARRANT 
THAT THE SOFTWARE IS ERROR FREE OR WILL OPERATE IN AN UNINTERRUPTED MANNER. SOME JURISDICTIONS DO NOT ALLOW 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THESE LIMITATIONS MAY NOT APPLY TO YOU IN 
THEIR ENTIRETY. NO JCITS SYSTEMS AGENT, OR EMPLOYEE IS AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR 
ADDITIONS TO THIS WARRANTY. If you make any modification to the Software during the warranty period; if the media is subjected to 
accident, abuse, or improper use; or if you violate the terms of this EULA, then this warranty shall immediately be voided. This warranty 
shall not apply if the Software is used on or in conjunction with hardware or software other than the unmodified version of hardware and 
software with which the Software was designed to be used as described in the documentation. THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY FROM STATE TO STATE OR FROM ONE JURISDICTION TO 
ANOTHER. 
 
9. LIMITATION OF LIABILITY. 
TO THE MAXIMUM EXTENT ALLOWED UNDER APPLICABLE LAW: (I) UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, 
TORT, CONTRACT, OR OTHERWISE, SHALL JCITS SYSTEMS OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER 
PERSON FOR ANY INDIRECT, SPECIAL, EXEMPLARY, INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION 
EVEN IF JCITS SYSTEMS SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES; AND, (II) IN NO EVENT SHALL 
THE AGGREGATE LIABILITY OF JCITS SYSTEMS, ITS SUPPLIERS AND RESELLERS UNDER THIS EULA EXCEED JCITS SYSTEMS' LIST 
PRICE FOR A LICENSE TO THE SOFTWARE. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR 
PERSONAL INJURY TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES OR 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS 
LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU IN ITS ENTIRETY. 
 
10. GENERAL. 
This EULA represents the complete agreement concerning this license between the parties and supersedes all prior or contemporaneous 
agreements and representations between them with respect to the subject matter. This EULA may be amended only in a writing executed 
by both parties. THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR 
ASSENT TO THE TERMS SET FORTH IN THIS EULA, AND NOT THOSE CONTAINED IN YOUR PURCHASE ORDER, AND SUCH 
PURCHASE ORDER TERMS SHALL HAVE NO EFFECT ON THIS EULA. If any provision of this EULA is held to be unenforceable for any 
reason, such provision shall be reformed only to the extent necessary to make it enforceable and the remainder of this EULA shall 
nonetheless remain in full force and effect. This EULA shall, for all purposes, be construed, governed by and enforced solely and 
exclusively in accordance with the laws of the state of California, USA without giving effect to its conflict of law provisions or your actual 
residence in another state or jurisdiction, except as governed by Federal law. You hereby agree that the courts located in San Diego, 
California, USA, will constitute the sole and exclusive forum for the resolution of any and all disputes arising out of or in connection with 
this EULA and you hereby irrevocably consent to the personal jurisdiction and venue of such courts and irrevocably waive any objections 
thereto. You hereby irrevocably consent to service of process for all actions in such courts. Any judgments obtained by such courts may be 
entered and enforced against you in any jurisdiction where your assets are located. Notwithstanding anything in this EULA, JCITS 



 

Systems may, at any time seek injunctive relief to enforce its rights under this EULA in any court of competent jurisdiction. This EULA 
shall bind you and your successors and assigns but shall not be assignable, sublicensable or delegable by you except as expressly set 
forth herein, or with JCITS Systems' prior written consent. Any such purported assignment, sublicense or delegation in violation of the 
foregoing shall be void. This EULA shall bind and benefit JCITS Systems and its successors and assigns.  The application of the United 
Nations Convention of Contracts for the International Sale of Goods is expressly excluded from this EULA. No waiver of any rights under 
this EULA will be effective unless in writing signed by both parties, and such waiver is only effective for the specific instance referenced in 
such writing. 
 
11. SALE OF LICENSE 
Should you, the original licnesee, decide to terminate your license Agreement, and desire to sell your license to a third party, this is 
allowable provided that JCITS Systems is notified in writing. No transfer can be performed until JCITS Systems approves such transfer 
and generates a new license registration file. 
 
Simply put, DO NOT make illegal copies! One license, one computer!
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Introduction 

ScanAsPDF will allow you to scan any document, from one to thousands, on 
your TWAIN compliant flatbed or automatic document feed (ADF) scanner and 
output multi-page Adobe Acrobat Portable Document Files, (pdf)s. 

ScanAsPDF is designed for Windows 98, ME, 2000 and XP. NT and Windows 
95 should work just fine as well 

Minimum Recommended Requirements 

Windows 98, Me, 2000 or XP (Should operate fine under 95 and NT) 
PII type processor 333 MHz or faster 
256 Mb RAM 
2 megabytes of hard disk space (for program only) 
TWAIN Compatible Scanner 
Automatic Document Feed Recommended 

For upgrade information, technical help or to purchase a license, please visit: -

http://www.jcitssystems.com 

Copyright 2003-2006 by 
John F. Jarrett, JCITS Systems, LLC 
Jarrett Consulting, Information Technology Services and Systems, LLC 
PO Box 1222 
Show Low, Arizona 85902-1222 

For further information on how to use ScanAsPDF, please see the online help! 
Press F1 on any menu item or window! 

Shareware/Demo Version of ScanAsPDF 

If you have the shareware/demo version of ScanAsPDF, it is not "too" crippled. It 
will allow you to scan documents and create Adobe Acrobat PDF files but each 
page will be stamped noting that you are using a demo/shareware version. 
Also, you cannot edit the pdf file properties and that window always pops up 
with information on how to purchase a license. 

If you like ScanAsPDF, please purchase a license. Information on how to obtain a 
license and methods of payment can be found on our web site. 

PLEASE thoroughly test ScanAsPDF to make certain that this software if right 
for you! 
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About TWAIN Scanners 

Every scanner, from flatbed to compact page feed scanners to high end high 
speed scanners, have their differences and have different capabilities even 
though they state they are TWAIN compliant. 

TWAIN is simply an interface for programs to communicate to a graphics device 
such as a camera or in our case a document scanner. Did you know that TWAIN 
stands for Technology Without An Important Name? Go figure! 

In setting up your scanner, you will have to do several test scans to set 
brightness, contrast and maybe color levels in order to get a good looking scan 
and pdf document. Experiment a bit and make sure you somehow save or 
remember your settings. Some scanners always default to a pre-existing setting 
that may not be good for you. As an example, the LaserJet 1200 and 1300 
series of printers with scanner attached always defaults to 300 dpi and color. 
So, I have to select Show TWAIN Interface each time and make sure that the 
Custom settings box is checked. 

A ScanTek E3 flatbed scanner always keeps your last setting and only has to be 
reset if it was changed by some other program or scan you performed. If no 
changes were made, you may select to not show the ‘Show TWAIN Interface’ 
item. A Canon CanoScan scanner also keeps your last setting. On some PCs the 
scan progress dialog without the TWAIN interface showing is a bit flakey! It may 
appear partially in the upper left corner of your screen instead of centered. This 
has nothing to do with the ScanAsPDF program. 

When using the Automatic Document Feed (ADF) on a LaserJet 1200/1300 
series LaserJet with scanner attachment, even in its own software, the bottom 
of each page is cut off and the first page can sometimes be reproduced in this 
cutoff area; an obvious problem with their interface. Single sheet scans are 
perfect or multiple pages that have nothing printed in the last inch or two of the 
page. 

A Fujitsu fi4010CU ADF scanner works almost flawlessly, but if you get a paper 
jam it may skip a page or two on subsequent scans. 

When scanning into ScanAsPDF, make sure you are scanning in grayscale or 
color with a scan area set at 8 ½ X 11 or 8 ½ X 14 inches. A good starting 
scan resolution is at about 100 dpi. Do not go any lower for best results. 

Results will vary! Experiment and you’ll get exactly what you need out of your 
scanner… in most cases! 
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Getting Started 

Installation 

If you purchased ScanAsPDF directly on CD, you should have also received a 
floppy disk. This floppy disk contains your registration and license key. This file 
cannot be redistributed in any form or fashion. It is your license to enable all 
features of ScanAsPDF. If you reinstall ScanAsPDF, you will need this key file 
and floppy disk. Simply insert the CD into your CD-ROM drive and it should 
auto-start with the setup program running. If it does not auto-start, open your 
CD-ROM and double click the setup.exe file/icon. Simply follow the on-screen 
prompts. It is best to check the checkmarks for installing a desktop shortcut 
and a start menu icon so that ScanAsPDF can be easier to find and use! 

If you received the demonstration/shareware version by download or elsewhere, 
run the ScanAsPDF_vX.x_Setup.exe (X.x = the version numbers of ScanAsPDF). 
This file is also included on the CD-ROM and this is the only file which is 
redistributable as a demonstration/shareware version. 

After you have installed ScanAsPDF from CD ROM, you will have the option of 
installing the bonus program included, PDFCreator. PDFCreator allows any 
application that can print to a printer, to create a pdf file. This application is an 
Open Source project and works very well. Documentation and further 
information on PDFCreator is available in its installation directory and at 

http: / /sourceforge. net/proj ects/pdfcreator/ or 
http: / /sector7g.wurzel6. de/pdfcreator/ . 

Once installation is complete, you can begin using ScanAsPDF in 
demonstration/shareware mode right away. If you received the CD-ROM and 
floppy disk with your registration key, now is a great time to install your 
registration key. 

Insert the floppy disk into your floppy disk drive, which is usually a:. Next click 
on Start, Click Run and enter into the run dialog box: 

A: install 

This will copy the registration/key file into the default ScanAsPDF directory. 
This file completely unlocks the application for total usability. 

If you received the registration key as an email attachment, you must manually 
copy the ScanAsPDF.rg file to C:\Program Files\JCITS Systems\ScanAsPDF 
directory. 
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Running ScanAsPDF 

By now, everything should be installed and you should have a ScanAsPDF icon 
on your desktop. Double click the icon and in a few seconds you will see the 
main ScanAsPDF window. If you have the demonstration/shareware version, 
you will first see a ‘nag’ screen thanking you for trying ScanAsPDF. The main 
window, when you first run ScanAsPDF, looks like this: 

 

In the project preview window you will see two sample pages, which are simply 
the introductory pages. 

Fi le  

As a next step, you should become familiar with the menu items at the top of 
the form and the main buttons at the bottom of the form. The buttons on the 
bottom of the form correspond to menu items under the File menu item. 
Clicking Fi le  will produce this menu: 
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Flush All (New Project) 

The Flush All (New Project) menu item and button are identical. Clicking either will  clear all of 
your scanned documents and prepare you to scan new documents into a new project. 

Open Project 

Clicking on O p e n  P r o j e c t  will allow you to open a previously saved project. A 
project, which we are calling a JCITS File, (.jct), contains all of your scanned 
pages ready to be manipulated and turned into a multi-page pdf document. 

The directory you last saved a project into is saved when you close ScanAsPDF so 
you generally do not have to go and search for the directory that your projects 
are saved in. 

Project files can be quite large, but considerably smaller than saving each 
individually scanned page in its default format which is a jpeg image. 

Double clicking on a .jct file icon will automatically start ScanAsPDF with that 
project already loaded. The .jct file icon is identical to the ScanAsPDF program 
icon. 

Save Project 

Clicking on S ave  P r o j e c t  will allow you to save the current project and open it 
again later. A project, which we are calling a JCITS File. (.jct), contains all of 
your scanned pages ready to be manipulated and turned into a multi-page pdf 
document. 

The directory you last saved a project into is saved when you close ScanAsPDF so 
you generally do not have to go search for the directory in which to save your 
projects. 

Project files can be quite large, but considerably smaller that saving each 
individual scanned page in its default format which is a bitmap image. 

Select Source 

Clicking S e le c t  S o u r ce  will bring up the Window’s Select TWAIN Source dialog 
box. This allows you to select the scanner you wish to use. Many PCs have 
many TWAIN compliant devices which can be web cameras or still image 
cameras and scanners. Make sure you select your scanner or weird things can 
happen! 
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Select Autosave Scheme 

Clicking on Select Autosave Scheme will bring up a dialog box with several 
options allowing you to do scanning quickly and automatically naming your pdf 
file. This is advantageous in a work environment where a lot of items need to be 
scanned quickly with unique filenames. 

The options that you can select for a pdf filename are: 

Date + Time. This will simply give the pdf document a filename of todays date 
and the current time. I.E. '1/7/2004 20:47:43'. 

PCName + Time. This will give your pdf document a filename that includes the 
name of your computer plus the time. 

User Name + Time. This will give your pdf document a filename that includes 
your logged on user name plus the time 

Lastly, you need to select a directory where all of your auto-saved documents 
are going to be placed. 

All of these settings are saved for reuse so you need not enter them each time 
you use ScanAsPDF. 

Scan-It 

Clicking the Scan It button or going to File - Scan It, will scan your document. 
This starts the whole process! 

If you have Show TWAIN Interface checked under the Options menu, the TWAIN 
scanner user interface will appear before any scanning takes place. For your fist 
scans this option needs to be checked. 

Create It (Save PDF) 

The Create It (Save PDF) menu item and the Create It button are identical. 

Clicking either will create your pdf from all of the document images you have 
scanned. The project preview window gives you a visual image of the page 
number and types of documents you have scanned into your project. 

In version 1.4 and above, a dialog window will appear allowing you to select the 
drive, directory and file name you want and will give you the option of 
automatically attaching the pdf file to an email message! All you need to do is 
check, "Send PDF as an Email Attachment". After you create the file, your email 
client will start with the pdf file already attached. You can enter 
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information into the To: CC, BCC and Subject fields on the Save/Create 
Window or enter them into your email client once it appears. 

This feature uses MAPI to handle this process and all Microsoft email clients 
are MAPI enabled. 

Scan It and Create It (One Step) 

If you are proficient and know that all will be well or you are doing a large 
quantity of scanning, you can click the Scan-Create One Step button or File - 
Scan It and Create It (One Step) menu item. 

This will scan your document/s and then go right to the pdf creation stage. 
This saves you one button click and a bit of time! 

Import and Convert Picture Files 

Clicking on Import and Convert Picture Files will open up a new window which 
will allow you to select most any type of standard image or picture file and add 
it to your pdf project! 

 

Clicking Open Picture will allow you to open a picture file. The selected picture 
shows up in the left hand preview window as well as its proportionally scaled 
size in the middle right hand paper size window. This window and the final 
layout window are scaled to 8 ½ X 11 inch US paper. It will scale accordingly to 
any pdf page size selected. 

In the middle paper scale window, you can size the image up or down, rotate it 
or mirror it. Once you have finished any pre-finishing, you can then take your 
mouse and click on the far right paper scale window and position the image 
anywhere you desire on the paper. Once you are satisfied you can click on 
Accept Move. This locks the image and you can then add more pictures to this 
page. If you are satisfied and want to then add the finished page to your project 



 Page 8 

then click Add to Project. The preview and work areas clear and you are ready 
to do another page. 

Clear Last will clear your last move or change and Clear All does just that; 
starts you over with clean empty work and preview areas. 

Close closes this window and returns you to the main ScanAsPDF window. 

Export Project 

When you select Export Project, you can export the entire project and each 
page as an image. You can select: 

 

If you select JPEG, each page in your project will be named Page1.jpg, 
Page2.jpg etc. 

Print Setup 

Print Setup brings up a standard printer setup dialog which wil l  
provide a default  printer for your use. This especial ly helpful 
when you want to use the new Copy Center feature.  

Print Project 

Clicking Print will print out your entire pdf project. Each page that is seen in 
the preview window will be printed. If you have one document in the preview 
window then one page will print, (unless you set your printer to print more than 
one copy of the same page). If you have 10 pages in the project preview window, 
then all 10 pages will print. 

You cannot selectively print a page within your pdf project using Print. You can 
however, double click any page in the project preview window and have your 
default image viewer print that one page. 

Exit 

Clicking Exit in the menu or the Exit button will close ScanAsPDF. A dialog box 
will advise you that you are about to lose any scanned data and that 
ScanAsPDF is closing. 
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Edit  

When you click the Edit menu item the following menu will appear: 

 
 
 
All of these menu items can be accessed, just as easily, by right clicking your 
mouse on a thumbnail page in the project preview window. 

Add Sticky Note 

When you select A d d  S t i c k y  No te  from the menu and you have scanned some 
documents an 'Add Sticky Note' window pops open. 
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From here you can select the page that you want to add a "Sticky Note" to. 
However, if you had a page highlighted or selected, that page will automatically 
open in the Add Sticky Note preview window. You can also select the color of 
the "Sticky Note" The default color is yellow. If you select a darker color, the 
type (font) changes to white. 

In the text window you can add up to ten lines of thirty characters. Remember, 
no more than ten lines! After you have entered your text you can then click an 
area in the graphic of the page you selected where you want the sticky note to 
be attached. When you move the mouse into the page preview window, the 
cursor turns into a cross. The top left corner of the sticky note corresponds 
with the lower right corner of the cross. If you don't like the position, click 
somewhere else! 

When done, click the button that says, "Stick Note on PDF". The window will 
close and the preview window of all scanned documents is updated. 

If you click the Cancel button, no changes are written and the window will 
close. 

 

Add Watermark 

If you click on A d d  W a te r m a r k  you will have a new window appear which is 
similar to the Add Sticky Note. It will look something like this: 

 

In this window you can select several predefined Watermarks such as Copy, 
Confidential, Draft and others or you can enter your own text. You can select a 
font color and a font size. Once you have entered your text, you can place the 
text most anywhere on the page. When you move the mouse to the page preview 
window, you will see the cursor change to a cross. 
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You can select the position and angle of the Watermark as well. Those 
selections are Horizontal, Angled Down and Angled Up. If you have selected 
Horizontal or Angled Down, then when you click the right mouse button to 
place the Watermark, the text will appear starting in the lower right quadrant of 
the cross. If you have selected a position of Angled Up, then the cross cursor is a 
relative or close positioning of the Watermark. When the mouse cross is in the 
approximate "lower - left - center" of the page preview, the text will appear 
'approximate' to the mouse cross. Here the pointer is simply a rough guide. 

If you are not satisfied, you can change the position by clicking somewhere else 
until the position is just right. 

When you are finished, you can click on the P l ace  W a te r mar k  on  PDF  button or 
the C a n c e l  button. 
 

Swap Pages  

Selecting Swap Pages or Swap allows you to swap the positions of any two 
pages. 

Say you want the last page in your project to be the first page, or Page 1 and the 
first page to be the last page. Simply click on and highlight the first page you 
want to swap in the project preview window. You can right click the mouse and 
select Swap or you can go to Edit - Swap Pages. A dialog box will appear 
allowing you to confirm your first selection. After clicking 'Yes', click on the 
page in the project preview window that you want to swap with. As soon as you 
click the mouse on your second page choice, another confirmation dialog box 
appears asking you if you are certain that you want to swap these pages. If you 
are, click 'Yes'. The pages will swap and the project preview window will refresh 
letting you know that the operation was successful. 

Depending on the speed of your computer, this may take a few seconds. 

Move Page 

Selecting Move Page or Move will move one page into the position or sequence 
of another page. Thereby moving each page up. It is like inserting a page, but 
you are moving it to a new position. 

As an example, you want the last page in your project, for instance Page 10, to 
be the first page, or Page 1. Simply click on and highlight the page you want to 
move in the project preview window. In this example, Page 10. You can right 
click the mouse and select Move or you can go to Edit - Move Page. A dialog box 
will appear allowing you to confirm your selection. After clicking 'Yes', click on 
the page in the Project Preview Window that you want your first selection to 
become, in this example Page 1. As soon as you click the mouse on your choice, 
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another confirmation dialog box appears asking you if you are certain that you 
want to move this page into the new position. If you do, click 'Yes'. The page will 
move and the project preview window will refresh letting you know that the 
operation was successful. 

Again, depending on the speed of your computer, this may take a few seconds. 

Preview 

If you click Preview Page or Preview, the page that has been selected in the 
project preview window will be displayed in your default picture viewing 
software for bitmap images. You can even edit the page image in your paint or 
imaging program, but make certain that you save the file back into the same 
directory and with the current name. Never use Save As and change the name 
or folder in which the page resides. 

 

If you double click the page you want in the project preview window, the default 
image viewer or editor will appear with that page loaded. Double clicking is a bit 
easier. 

Any changes or edits you make to the image will be reflected in the project 
preview window. If you change the size of the image or do anything with 
dimensions of the page, it will produce a pdf file that is not scaled accurately. 

The only edits that should be made are to draw circles or arrows or add some 
text. After you save changes, ScanAsPDF may refresh several times depending 
upon how many pages are in your project. 

You can also right click the mouse on the page you want to preview and then 
click Preview. 

Delete Selected Page 

Selecting Delete Selected Page or Delete, will do just that; delete the page you 
have selected by clicking that page in the project preview window. 

You can delete a page by right clicking the mouse on the page you want to 
delete or click on the page and go to Edit - Delete Current Page. If you click the 
right mouse button, a popup menu appears with a Delete menu item. 

Click 'Yes' and that page is deleted. The remaining pages after the deleted page 
are renumbered.  
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All of the other Edit options are very self explanatory, such as Lighten and 
Darken and Print which does just that to the selected page. Rotate, Mirror and 
Negative change the selected page. If you select Negative, there is no changing it 
back! This is permanent. So is Convert To grayscale. 

Options 

When you click the Options menu item the following menu should appear: 

 
All of these are either on, (checked), or off, (unchecked) and the action is always 
performed when you scan or create a pdf document. 

 

Automatic Document Feed 

Automatic Document Feed needs to be checked if your scanner has an 
automatic document feed (ADF) on it. You can still scan single sheets with ADF 
enabled but this tells ScanAsPDF that more scans may be coming and does set 
some internal parameters. 

Single Sheet – Manual Feed 

If you have a flatbed scanner or you are going to use the bed of your ADF 
equipped scanner, then check Single Sheet - Manual Feed. 

US Letter 8.5 X 11 

This option pertains to the pdf document size that Acrobat Reader sees. If the 
documents you are scanning are standard US Letter size, click US Letter 8.5 X 
11. 
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US Legal 8.5 X 14 

This option pertains to the pdf document size that Acrobat Reader sees. If the 
documents you are scanning are US Legal size, then click US Legal 8.5 X 14. 

A4 Letter 210mm X 297 mm 

This option set a pdf page size to the European standard A4. 

Show TWAIN Interface 

Clicking on Show TWAIN Interface will ALWAYS bring up the TWAIN scanning 
user interface each time you click on Scan It or One Step. Some TWAIN 
scanners must be configured each time. Usually you will want this ‘checked’ to 
"tweak" the settings due to a bad original or first scan. 

Show Select Source 

Checking the Show Select Source will bring up the TWAIN Select Source dialog 
box before each scan job. 

Use Autosave Scheme 

Checking the Use Autosave Scheme menu option, enables the autosave scheme 
you chose under File - Select Autosave Scheme. 

User Selects Filename 

Checking User Selects Filename will always allow you to select and name your 
pdf file whatever you desire and email the pdf in one step. 

 

PDF Quality 

PDF Quality directly relates to the final file size of your pdf document. When 
set, a checkmark will appear by the quality you have selected. If set to Best, the 
pdf file size and quality will be at its very best. When set to Better, this will 
produce a medium quality pdf document. The difference between Best and 
Better may be visually hard to see. And finally, for the smallest pdf file size, 
choose Good. This will yield the smallest file size and it is doubtful you will be 
able to see any major differences in the final pdf quality. It is there, but in most 
documents it will be hard to see. 
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Edit PDF File Properties 

Checking the Edi t  PDF F i le  Prope ties  menu item will cause a dialog box to pop 
up after the file name is set or asked for. This box allows you to enter a different 
document name, other than, for example, 'filename.pdf'. It also allows you to set 
the author name and any keywords needed if you need to search the pdf 
document via keywords. 

The author name is saved from session to session so you only need to enter 
that information one time. 

View PDF After Creation 

Checking View PDF After Creation will do just that! It starts up your Adobe 
Acrobat Reader and displays the document you just scanned and created. 

Convert Color to Grayscale 

This option is only available in version 1.3 and above. 

When checking the Convert Color to Grayscale menu item, any document that 
is scanned in color will be converted to gray scaled - black and white. This does 
not affect "Sticky Notes' as they will remain in color. 

The purpose behind this is to simply make a smaller pdf file. Color pdf files are 
larger and there are times that you need to keep your sizes as small as 
possible.  

Copy Center.  

The Copy Center is a neat little utility to simply scan and copy your documents 
to a printer. A lot of scanner utilities have a 
copy function, but this is unique in that you 
can add all pages to a new project and 
create a pdf or save the project. 

You must set the number of copies first, 
such as 0 - 1 for one copy,  0 – 2 for two 
copies, etc. You can adjust outputted print 
size as well as lighness or darkness. 

Once you close the Copy Center, all of the 
documents you scanned will appear in the 
Project Preview Window. You can then 

discard them or create a pdf or save it as a project. 
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Help  

Clicking the Help menu item will bring up the following menu. 

 

ScanAsPDF Help 

Clicking ScanAsPDF Help  will bring up the first page of the included context 
sensitive Help file. Pressing F1 when the mouse is over most any object will 
bring up help for that item. 

Registered To 

Clicking Reg is tered To  will bring up a form that provides registered user 
information. If ScanAsPDF is not registered, then it is in 
Demonstration/Shareware mode and of course there will be no information in 
this window. 

About 

About provides a form that gives copyright information, program version and 
locations on where to get updates to ScanAsPDF. 



 

Your First Scans 

For your fist scans, set all of the Options as follows: 

Go to your menu bar and click 
Options. Click on Single Sheet-
Manual Feed Click on Show 
TWAIN Interface 
Click on Show Select Source 
Click on User Selects Filename 
Click on Edit PDF Properties 

You will have to repeat this until the items mentioned above all have 
checkmarks in front of them. 

Put something you would like to scan in your 
scanner.  

Click on the button Flush All (New Project) 
 
Now click on the Scan It button. 

The select source dialog box should appear. You may see more than one 
item in this box so make sure you select your scanner and best of all 
your 32 bit scanner if such is mentioned. 

Once that is done and you have clicked on the Select button, your 
scanner TWAIN interface window should appear. In this window you need 
to make sure that an 8½ X 11 scan size is set. Set the resolution to 
around 100 dots per inch and you can select either grayscale or color. 
Black and white usually does not show up very well and text is poor in 
this mode, so grayscale is the best preference. 

Click on the scan button in your scanner’s interface window. If all is well 
and your scanner is properly hooked up, it will start to scan the 
document. When it is finished, and depending on the speed of the 
interface and your computer, you should see an image of what you just 
scanned, appear in the project preview window. From this image you 
can see if it is too dark, or streaked or possibly too light. Looking a bit 
too light is preferred, but you must experiment with your scanner 
settings. 

 

 



 

 

Now, click on the ScanAsPDF “Create  I t ”  button. The following window 
should appear: 

 
Here you can select a drive, 
directory and a file name. 
An easy place to put this 
file for right now would be 
on your Desktop and give 
it the name of Test. The 
extension .pdf, will be 
added automatically. 

If you want to, check the 
Send As An Email 
Attachment and fill out 
some of the other 
information. If you do, 
after you click the S av e  

button and your pdf is 
created, your email client 
should start with the pdf 
file already attached and 
the information you 
supplied already entered. 

You now know how to use the basics of ScanAsPDF! Scan more 
documents, move pages, swap pages delete pages and preview some as 
well. You can’t hurt ScanAsPDF so enjoy your new productivity tool. 


